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 I. Introduction to the Inspector
The LONI Inspector is an application for examining medical image files.  Unlike most image
viewers, the Inspector focuses on reading, displaying, searching, comparing, and exporting
"metadata."  The term “metadata” refers to data that describes the image data in a file.  For
example, metadata can be the patient name, the model of scanner on which the subject was
scanned, the date on which the scan occurred, and the width and height of the image.  Knowledge
of metadata can be very important in understanding the imaging protocol and in protecting patient
privacy since Federal regulation prohibits the exchange of image files that contain patient
identifying information.

There are many different types of medical image file formats, and the amount and type of
information stored in these files varies depending upon the file format type and file creator.
Unlike simpler file formats (GIF, JPEG), there is often a large amount of metadata (subject name,
date of birth, scanner protocol) stored with the image data.  The Inspector provides a single
interface for viewing both metadata and image data in many common medical image file formats
(AFNI, ANALYZE, DICOM, ECAT, GE, Interfile, MINC, NIFTI), searching files for keywords,
comparing files for differences, and exporting metadata into XML and CSV files.
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 II. Starting the Inspector

 A. Unzipping the downloaded file
From the LONI software download web site, you should be able to download the zip file:

inspector_2_0.zip

Unzip the file into its contents.  This should create the following files:

File Description

Inspector2_22Jun2007.jar The main Inspector jar file 

run.sh Use to run the Inspector in Linux/OS X/Unix

run.bat Doubleclick to run the Inspector in Windows

 B. Starting the Inspector
In order to run the Inspector, you must have Java 1.5 or later installed on your machine.  The
Inspector has been tested on and successfully run on Windows, Linux, and OS X platforms.  On
Windows, doubleclick the run.bat file.  On other platforms, open a command line shell and
execute the run.sh script (It may be necessary to "chmod a+x run.sh" first if the file does not have
executable permissions).

 C. Selecting files as command line arguments
You can automatically load files into the Inspector by specifying them as command line
arguments:

java jar Xmx1024m Inspector2_22Jun2007.jar <file1> <file2> <file3> ...

If no arguments are given, the Inspector will start as if you had executed the run.sh or run.bat file.

 D. Supported File Formats
AFNI
ANALYZE 7.5
DICOM
ECAT 7
GE 5.0
Interfile (including HRRT Interfile)
MINC
NIFTI
Variants of GIF, JPEG, and PNG
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 III. Selecting files
In order to load files into the Inspector, they must first be selected in the selection dialog.

 A. How to start the selection dialog
The Inspector file selection dialog is started using the menu option “File>Add/Remove Files.”
This will display a dialog similar to:
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 B. How to select a file
There are multiple ways to select files in the Inspector file selection dialog.

 i.  Doubleclick
If you doubleclick on a file in the lower treelike display of your file system, the file (and those
associated with it) will be selected and displayed in the upper part of the dialog.
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 ii. Single click and "Add Files"
If you click on a file in the lower part of the file selection dialog and then click the “Add Files”
button, the file (and those associated with it) will be selected and displayed in the upper part of the
dialog.
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 iii. Draganddrop
If you select a file with the mouse in the lower part of the file selection dialog and then drag the
mouse (with the mouse button pressed) over the upper part of the dialog, the file (and those
associated with it) will be selected and displayed in the upper part of the dialog when you release
the mouse button.
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 D. How to select a directory of files
To select all the files in a directory, single click on the directory and click the “Add Files” button.
The contents of the directory will be selected and displayed in the upper part of the dialog.
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 E. How to remove selected files
To remove a file from the Inspector, select the file in the upper part of the file selection dialog
(hold down the CTRL key to make multiple selections, or hold down the SHIFT key to select
multiple files at once).  Click the “Remove Files” button to remove the selected files.
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 F. How to remove all the selected files
To remove all selected files from the Inspector, click the “Remove All Files” button.

 G.   File loading progress
A progress dialog will appear while the Inspector loads files in the event that a large number of
files are selected.
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 H. Unsupported file formats
Files that cannot be recognized by the Inspector are reported in a dialog after the loading process
finishes:
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 IV. Inspecting metadata
The term “metadata” refers to data that describes the image data in a file.  For example, metadata
can be the name of the subject that was scanned, the date on which the scan occurred, and the
width and height of the image.  Each “file format” (e.g., DICOM, ANALYZE, or JPEG) contains
different sets of metadata elements.

 A. Name and description columns
The “name” column of the Inspector lists the names of the metadata elements that are present in
the chosen file(s).  The “description” column gives a brief description of each metadata element.
If there isn't information about a metadata element (e.g., a privatelydefined element), then the
description for the metadata element will be blank.
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 B. How to identify the file format
The first row of metadata displayed in the Inspector gives the file format.

 C. How to add or remove a column
Two or more files can be compared sidebyside by “adding a new column.”  A new column is
added using the menu option “View > Add column.”  This menu option will not be active if there
are no more files to compare.  A column is removed by clicking the “X” button located at the top
right corner of the column.
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 D. Opening a new window
Use the menu option “View > New window” to open a new Inspector window.  All files currently
loaded into the Inspector will be accessible in the new window.

 E. Resizing the columns
The width of each table column can be changed.  Move the mouse cursor over a column divider
and, while holding the mouse button down, drag the divider left or right to change the column
widths.
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 F. How to change the displayed files
At any given time, the Inspector will display metadata from only one file format.

 i.  Leftmost file column chooses the file format
The file format of the file chosen in the leftmost file column determines what metadata elements
are displayed in the name and description columns. 
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 ii. Other file columns list only files of this file format
When there is more than one file column displayed in the Inspector, all other file columns (other
than the leftmost file column) contain files of the same file format.   For example, if a DICOM file
is chosen in the leftmost file column, only DICOM files will be listed in the other file columns.
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 iii. Changing the file format in the leftmost file column
If you select a file in the leftmost file column that has a different file format than the file currently
selected in the column (e. g., change the selection from a DICOM file to an ANALYZE file), the
content of the name and description columns will change to match the new file format and the
other file columns will switch to files of the new file format.
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 G. What does <NO DATA> mean?
When two or more files are compared sidebyside, it is possible that one file will contain
metadata elements that are not present in the other files.  If this occurs, the label “<NO DATA>”
is displayed where the metadata is missing.  This makes it possible to distinguish the case where a
value is missing (<NO DATA>) from the case where the value is empty (“”).

 H. Viewing long metadata strings with tool tips
If a table cell is not wide enough, the cell value will be truncated and dots (...) will appear at its
end.  The full string can be displayed by moving the mouse cursor over the table cell.  After about
two seconds, a tool tip will appear showing the full value.

 I.  Differences in row color and >'s
Some metadata elements are contained inside other metadata elements.  The “>” symbol appears
in front of metadata elements that are contained in other metadata elements.  Many “>”'s indicate
many levels of containment.  The background color get darker with the number of “>”'s.
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 V. Searching for metadata

 A. Keyword search
Click on the “Search” tab in the lower left corner of the Inspector to activate the search function.
Type text in the “keyword” field to search for all occurrences of the text.

 i.  Searching for name, description, and value

Name Search the name column (names of the metadata elements).

Description Search the description column (descriptions of the metadata elements).

Value Search all the columns excluding the name and description columns
(metadata from the files).
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 ii. Case insensitive search
All keyword searches are case insensitive.  For example, searching for “LONI” is equivalent to
searching for “loni” and “LoNi”.  The results of keyword searches return all occurrences of the
keyword.  For example, searching for “loni” would yield results such as “LONI”, “loni.ucla.edu”,
and “cloning.”  All table cells that contain a keyword match are colored blue:

 iii. Reset button
To clear the results of a search, click the “Reset” button.
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 B. Highlight Keyword Rows
Choose the “Highlight Keyword Rows” option to color all table cells with keyword matches.
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 C. Hide NonKeyword Rows
Choose the “Hide NonKeyword Rows” option to hide all rows without keyword matches.  To
show all the rows again, click the “Reset” button.
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 VI. Comparing metadata

 A. Compare tab is active when two files can be compared
Click on the “Compare” tab in the lower left corner of the Inspector to activate the compare
function.  This function is only available when there are two or more columns visible in the
Inspector.  
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 B. Highlight Differences
Choose the “Highlight Differences” option to highlight the differences between files.  Each row
that contains differences is colored blue.  If there are many values for a metadata element and at
least one value differs between two files, then all rows containing the values are colored blue.
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 C. Only Show Differences
Choose the “Only Show Differences” option to show the differences between files (while hiding
the similarities).  This option is useful when there are only a few differences between files.
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 VII. Exporting and copying metadata
There are two ways to export metadata from the Inspector, and one way to copy metadata.

 A. Export as XML
Click the XML button (located near the upperleft of an image) to write the metadata as an XML
file.  You must supply the name of the XML file in the dialog that pops up.
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 B. Export as CSV
Click the CSV button (located to the right of the XML button) to write the metadata as a CSV file.
A CSV file contains a commadelimited version of the metadata.  You must supply the name of
the CSV file in the dialog that pops up.

 C. Copy a cell value
The value shown in a table cell can be copied to the system clipboard and then copied to other
applications.  Move the mouse cursor over the cell and rightclick the mouse (hold down the
command key as well in OS X) to bring up the copy menu.  Click on the copy menu item to copy
the cell value.  The keyboard shortcut (e. g., CTRLC) for your operating system can also be used.
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 VIII. Viewing images

 A. A few images are automatically shown
For each file selected in a file column there will be one or more images displayed at the bottom of
the Inspector (depending upon how many images are stored in the file).
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 B. Image number and total number of images
Two numbers are displayed in the bottom left hand corner of each image.  The first number is the
number of the displayed image and the second number is the total number of images in the file.
For example, “1/3” means that image #1 is displayed and there are 3 images in the file.

 C. Viewer button launches a popup viewer
Click the VIEWER button (above each image) to start the image viewer.  The image viewer
displays all the images in the file.
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 i.  Progress bar shows loading progress
If there are many images in the file, it can take a few seconds to read them all into the image
viewer.  A progress window will appear to report on the loading progress.  When the progress
reaches 100%, the progress window disappears and the image viewer is shown.

 ii. Resizing the window changes the image size
When the image viewer window is changed, the image displayed inside of it is rescaled
accordingly.  On most operating systems, the window can be resized by selecting the bottomright
corner of the window with the mouse and dragging it to the desired size.
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 iii. Scrolling the mouse on the image changes the image in view
The image viewer will only display one image at a time, even if there are many images in the file.
The displayed image can be changed by moving the mouse cursor onto the image, holding down
the leftmost mouse button, and dragging the mouse cursor up/down.  If there is only one image,
no change will occur.

 v. Clicking the top/bottom of the image changes the image in view
The displayed image can also be changed by moving the mouse cursor to the top (or the bottom)
of the image and clicking the leftmost mouse button.  The next image displayed will be the
previous (or next) image in the image sequence.  If there is only one image, no change will occur.

 vi. Rotating and flipping the image
The orientation (rotation and flip) of the displayed image can be changed by moving the mouse
cursor onto the image and clicking the middle mouse button (hold down the option key in OS X).
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 IX.  Quitting the Inspector
To quit the Inspector application, select the “File > Exit” menu option, hold down the CRTL and
“E” keys, or just close all the Inspector windows.
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